DAFTARISI
MODUL 6 ....eeneeiiiiniieensnesseesseesssesssesssesssesssessssssssssssssssssssssssssssssssssssssssssssssnsssnsssnsssnsssnsssnsssnsssnsssnssnsssnsssnssssssnns 2
MENGENAL FASILITAS TAMBAHAN LAINNYA PADA MS. WORD DAN MS. EXCEL .......cccceeevtiininrenereensssnnessnnnsenes 2
6.1. FUNGSI & FASILITAS TAMBAHAN LAINNYA PADA MS. WORD .......cuvrtirieeirienienisieneeneeiesieeereseeeeteseeneetesaeneeseseeneenens 2
6.1.1.  Membuat Daftar Tabel dan GAMDAY .............ccoeeeeeeeieieieiesese sttt ettt sieste e eanens 2
6.1.2.  Membuat Pengaturan Nomor Halaman Berbeda Pada Sebuah DOKUMEN.............ccccvvecvevevveviesecieiaiiannns 3
6.2. FUNGSI & FASILITAS TAMBAHAN LAINNYA PADA MS. EXCEL ......eeuveieieriisierieeiiete ettt st 4
6.2.1.  Mengenal FUNGSi SOM TADIE .........ccveueeeeeieeeiee st eeee ettt e et e e e ta et et ete e e eta e e enseseens 4
6.2.2.  Mengenal FUNGSi Fler TADIE ............coveeruerieieieieeeeseteeet ettt ettt 5
6.2.3.  Mengenal Print Are@ & PriNt THIES ........ccvecveeeerieesieieieiesesesesttetteteiestestes e ste e e sssessetesessessassesssesnens 6
6.2.4.  Mengenal Fasilitas Conditional FOrMAMNG .........c.ceueuererieirinieieinieieeee ettt 6
6.2.5. Mengenal Fasilitas Freeze Panes dan SPlit............ceceveeieeeieiiesiesiesiesieteieiesiesese st eeeaesessessesse s 7

Politeknik Kesehatan Medan — Jurusan Keperawatan




Modul 6

Mengenal Fasilitas Tambahan Lainnya Pada Ms. Word Dan Ms. Excel

Tujuan Praktikum :

o Praktikan mengetahui fasilitas daftar tabel dan gambar pada Ms. Word yang dapat digunakan pada saat
membuat dokumen

o Praktikan dapat mengatur nomor halaman sesuai kebutuhan penulisan dokumen

e Praktikan mengetahui dan dapat menggunakan fungsi sorting dan filter data pada Ms. Excel

o Praktikan mengenal fasilitas Print Area dan Print Titles pada Ms. Excel sehingga dapat mempermudah
pengaturan pada saat mencetak dokumen

e Praktikan dapat menggunakan pengaturan tambahan pada tabel seperti Conditional Formatting, Freeze
Panes & Split Worksheet

6.1.  Fungsi & Fasilitas Tambahan Lainnya Pada Ms. Word

Selain fasilitas-fasilitas yang dapat digunakan untuk pengetikan dalam membuat dokumen, ada beberapa
fasilitas lainnya yang dapat digunakan pada Ms. Word. Contohnya dalam membuat daftar tabel dan gambar
pada sebuah jurnal atau tulisan ilmiah, Ms. Word memberikan fasilitas sama seperti saat kita membuat daftar isi
secara otomatis. Selain itu, Ms. Word juga dapat membuat penomoran halaman yang berbeda jenisnya dalam
sebuah dokumen. Fungsi-fungsi seperti ini sangat berguna dalam pembuatan dokumen atau karya tulis.

6.1.1. Membuat Daftar Tabel dan Gambar
Hampir sama seperti pada saat kita membuat Daftar Isi secara otomatis, pada Ms. Word kita juga dapat
membuat referensi gambar dan tabel.

2.1. Menyisipkan Gambar

Microsot. Wor R 21 ke galam dokumen.
Langkah-langk Caption: ture. Pllih file gambar,.
yang ingin disis [Sambar 1]
Options
Lebel:  [Gambar |

G Bl Position: [Below selected item >

- ™ Exchude label from caption
[dew Label,.. | Delete Label | Mumbering... |

AutoCaption... | oK | Close |

Langkah-langkah untuk membuat daftar gambar secara otomatis adalah :

1. Klik pada gambar yang ada pada dokumen
2. Klik Tab Ribbon References
3. Klik tombol Insert Caption, maka akan muncul kotak dialog seperti di bawah ini
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. icaption:

; IFigure 1| |

- Dptions

Label: IFigure

Lt e

I Position: IBelow selected item

" I Exdude label from caption

Mew Label. .. | Delete Label | Murmbering. .. |

BukoCaption, ., | O, I Cancel |

4. Klik New Label untuk mengganti penamaan pada referensi gambar. Isikan nama Label, seperti Gambar

dan klik OK
Label: Lahel;
| I IGambar|
oK I Cancel | ok I Cancel |

5. Pilih posisi penamaan Gambar pada pilihan Position. Above seiected item untuk posisi di atas gambar
dan Below selected item untuk posisi di bawah gambar. Posisi yang biasa digunakan untuk daftar
gambar adalah di bawah gambar.

21
. Caption: 1
: IGambar 1

Dptions
Label: IGambar j
| Position: IBalnw selected item |z|
{ Abiove selecked item
I Excludde [ :
Mew Labg
AutoCapt : :

6. Label gambar beserta indeksnya akan muncul secara otomatis, maka berikan penamaan pada gambar
tersebut.

7. Lakukan langkah-langkah seperti di atas untuk gambar-gambar lainnya pada dokumen.

8. Setelah selesai membuat penamaan pada seluruh gambar, posisikan kursor pada halaman untuk daftar
gambar.

9. Klik kembali Tab Ribbon References dan tombol Insert Table of Figures pada kelompok Captions. Maka
akan muncul daftar dari penamaan gambar yang telah dibuat sebelumnya beserta posisi halamannya.

Untuk pembuatan daftar tabel pada dokumen, langkah-langkahnya adalah sama seperti membuat Daftar
Gambar di atas.

6.1.2. Membuat Pengaturan Nomor Halaman Berbeda Pada Sebuah Dokumen

Pada sebuah dokumen, baik dokumen biasa ataupun dokumen ilmiah, terkadang kita membutuhkan beberapa
jenis penomoran halaman yang berbeda dalam sebuah dokumen. Yang dimaksud adalah misalnya pada
dokumen ilmiah untuk halaman yang isinya berjenis indexing atau referensi biasanya kita memberikan
penomoran berjenis angka romawi kecil seperti i,ii, iii, dst, sedangkan sisanya kita memberikan penomoran
berjenis angka biasa seperti 1,2,3, dst.

Untuk membuat pengaturan penomoran seperti ini tidak dapat menggunakan fasilitas Insert Page Number
seperti biasa. Kita perlu menambahkan pengaturan untuk halaman - halaman tersebut terlebih dahulu. Langkah-

Politeknik Kesehatan Medan — Jurusan Keperawatan




langkah mengaturnya ada beberapa cara, namun kita akan membahas salah satu langkah yang dianggap lebih
mudah.

llustrasi awal :

Halaman1-5 : Cover, Kata Pengantar, Daftar Isi, Daftar Gambar & Tabel, dll. Diberi penomoran i-v
Halaman 6 dst  : Isi dokumen, diberi penomoran 1 dst.

Langkah-langkah member penomoran halaman :

1. Dapat dilakukan dengan menyelesaikan terlebih dahulu teks atau dokumen.

2. Setelah dokumen selesai, posisikan pada awal halaman 6, lalu pilih Tab Ribbon Page Layout -
Breaks - Next Page

3. Blok halaman1-5

4. Pilih Tab Ribbon Page Layout > Menu Advance Page Setup = Tab Layout - Pastikan Section Start-
nya adalah New Page dan Apply To-nya adalah Selested Sections atau Selected Text.

5. Pilih Tab Ribbon Insert > Page Number, pilih menu Format Page Number, dan pilih jenis penomoran

yang diinginkan (i, ii, iii, ...).

Pilih Start at 1 pada Page Numbering, dan OK

Blok kembali halaman 6 sampai dengan selesai.

Ulangi langkah ke-4

Tanpa melepas blok teks, pilih Tab Ribbon Insert - Page Number, pilih menu Format Page Number,

dan pilih jenis penomoran yang diinginkan (1, 2, 3,...).

10. Pilih Start at 1 pada Page Numbering, dan OK

11. Jika dilakukan dengan benar, maka halaman 1 — 5 akan berubah menjadi i — v, dan halaman 6 sampai
dengan selesai akan menjadi 1 dst. Jika belum benar penomoran tersebut, maka kembalikan
pengaturan halaman awal dengan cara blok seluruh dokumen - Tab Ribbon Page Layout - Advance
Page Setup - Tab Layout = Apply To : Whole Document, lalu pilih Tab Ribon Insert > Page Number
- Remove Page Numbers dan ulangi kembali langkah-langkah di atas.

© o N>

6.2. Fungsi & Fasilitas Tambahan Lainnya Pada Ms. Excel

Pada modul-modul sebelumnya kita telah membahas pengenalan tampilan dasar dari Ms. Excel 2007 beserta
fungsi-fungsi dasar yang umum digunakan dalam pengolahan data. Selain fungsi-fungsi dasar tersebut, terdapat
fasilitas tambahan pada Ms. Excel 2007 yang dapat kita gunakan untuk mempermudah pekerjaan kita dalam
mengelola data.

6.2.1. Mengenal Fungsi Sort Table
Fungsi Sort berguna untuk mengurutkan data. Fasilitas ini terdapat pada Tab Home dan kelompok Editing.

Sort & | Find &
Filter = | Select~
4] sortatoz

2] sortZtoas

X AutoSum T W [?a WH Custom Sort.
@] Fill ~

W= | Filter
Sort & |Find &
4 Clear = Filter = | Select~

Editing

Politeknik Kesehatan Medan — Jurusan Keperawatan




Jenis Sorting “Sort A to Z" akan mengurutkan dari nilai terkecil ke nilai terbesar. Sedangkan “Sort Z to A’
berfungsi sebaliknya. Untuk jenis sorting “Custom Sort...” digunakan jika data yang ingin diurutkan berdasarkan
sebuah kolom tertentu atau berdasarkan lebih dari 1 kolom. Syaratnya adalah data harus di blok terlebih dahulu.
Jika data yang kita blok mempunyai label kolom, maka ceklis pilihan “My data has headers”. Lalu pilih kolom
acuan pertama untuk diurutkan pada pilihan “Sort by” dan pilih jenis pengurutannya pada pilihan “Order”. Klik
Add Level untuk menambahkan kolom acuan pengurutan kedua dan seterusnya. Maka data akan diurutkan
berdasarkan Kolom Pertama lalu hasil urutan tersebut diurutkan lagi berdasarkan Kolom Kedua dan seterusnya.

o 2lx
) addlevel X Deletelevel U3Copylewel | o Options I~ My data has headers
Colurn [5ort on [ Order |
Sortby [ =] [elues =] [atoz |

Concel
7]

6.2.2. Mengenal Fungsi Filter Table

Fungsi Filter Table merupakan fasilitas untuk menyaring data pada dokumen Spreadsheet kita berdasarkan
kategori tertentu. Fungsi ini digunakan unutuk mempermudah kita mencari data. Caranya adalah blok terlebih
dahulu data lalu Pilih Menu Sort & Filter pada Tab Ribbon Home, dan pilih Filter. Maka akan muncul panah filter
pada seluruh label kolom (baris pertama) data.

1
2 1 |DESI 1B 3 1.500.000 400.000 300.000 2.200.000 19.800 2.180.200
3| 2 |NINA 1IC 2 1.000.000 200.000 200.000 1.500.000 12.000 1.488.000
4 3 |ARYA 1A 1 2.000.000 500.000 100.000 2.600.000 26.000 2.574.000
s | 4 |WAWAN 1IC 3 1.000.000 300.000 300.000 1.600.000 12.800 1.587.200
& 5 |BUDI 1B 0 1.500.000 400.000 = 1.900.000 17.100 1.882.900
7| 6 |ADE 1IC 3 1.000.000 300.000 300.000 1.600.000 12.800 1.587.200
s 7 |WATI 1B 2 1.500.000 400.000 200.000 2.100.000 18.900 2.081.100
3| 8 |ADE 1A 2 2.000.000 500.000 200.000 2.700.000 27.000 2.673.000
1w 9 |HARI 1A 1 2.000.000 500.000 100.000 2.600.000 26.000 2.574.000
11, 10 |ASEP 1A 2 2.000.000 500.000 200.000 2.700.000 27.000 2.673.000

Jika tanda panah tersebut diklik maka akan muncul pilihan penyaringan sesuai data yang diinginkan. Ceklis data
yang ingin ditampilkan, maka data pada tabel akan muncul hanya jika isinya sesuai dengan syarat penyaringan
tersebut.

1

2 1 73l sortatoZ 3 1.500.000 400.000 300000 | 2200000| 19.800| 2.180200
o 2 ¥ ?::(A‘ , 2 1.000.000 300.000 200.000 | 1.500.000 | 12.000 | 1.488.000
4 3 i 1 2.000.000 500.000 100.000 | 2.600.000 | 26.000 | 2.574.000
s 4 8 3 1.000.000 300.000 300.000 | 1.600.000 | 12.800 | 1.587.200
g 5 |f Tethrs > 0 1.500.000 400.000 s 1.900.000 | 17.100 | 1.882.900
7 6 e 3 1.000.000 300.000 300.000 | 1.600.000 | 12.800 | 1.587.200
s 7 i 2 1.500.000 400.000 200000 | 2.100.000 | 18.900| 2.081.100
i 2 2.000.000 500.000 200,000 | 2.700.000 | 27.000 | 2.673.000
w 9 1 2.000.000 500.000 100.000 | 2.600.000 | 26.000 | 2.574.000
1 10 2 2.000.000 500.000 200,000 | 2.700.000 | 27.000| 2.673.000
12

13 oK Cancel

10 Tahal 3 Tahal Rafaranci Tunianocan
Hasilnya :
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4 3 |ARYA 11A 1 2.000.000 500.000 100.000 2.600.000 26.000 2.574.000
s 8 |ADE 1A 2 2.000.000 500.000 200.000 2.700.000 27.000 2.673.000
1w 9 |HARI 1A 1 2.000.000 500.000 100.000 2.600.000 26.000 2.574.000
11, 10 |ASEP 1A 2 2.000.000 500.000 200.000 2.700.000 27.000 2.673.000

Pilih Clear untuk menghapus Filter dan Re-apply untuk mengatur ulang filtering data.

6.2.3. Mengenal Print Area & Print Titles

Print Area digunakan untuk mengatur daerah pada dokumen spreadsheet yang akan dicetak. Caranya adalah
blok data/range yang ingin dicetak, pilih Tab Ribbon Page Layout - Print Area - Set Print Area. Maka hanya
yang diblok tersebutlah yang akan tampil pada saat dicetak. Pilih Clear Print Area jika ingin mengatur ulang
daerah yang akan dicetak.

Jika ingin lebih mudah melihat daerah yang akan tercetak, pilih jenis tampilan “Page Break View”. Daerah
dengan background atau latar berwarna putih dan berada di dalam garis biru adalah daerah yang akan dicetak.
Sedangkan garis bputus-putus berwarna biru adalah pembatas halaman. Garis tersebut dapat didrag dan diatur
berdasarkan keinginan posisi terakhir halaman yang ingin dicetak. Jika pengaturan letak halaman tersebut
dianggap oleh Ms. Excel melebihi batas kertas, maka Ms. Excel akan secara otomatis mengecilkan skala
tampilan dari dokumen.

6.2.4. Mengenal Fasilitas Conditional Formatting

Fasilitas Conditional Formatting mempunyai salah satu fungsi untuk memberi tanda sesuai dengan syarat yang
dipilih atau diberikan. Contohnya adalah dalam suatu data, kolom A ingin ditandai jika datanya ada yang bernilai
0. Maka menggunakan Conditional Formatting kita bisa memberi tanda dengan warna sel tertentu secara
otomatis.

Untuk memberi tanda jika data JUMLAH ANAK ada yang bernilai 0, maka langkah-langkahnya adalah sebagai
berikut :

1. Blok kolom atau data yang ingin dicek dan diberi tanda, yaitu kolom jumlah anak.

A B e D E F G H | 1
1 GAIl POKOE  INTENSIF @ TUNJANGAIS GAIl KOTORS PAJAKE GAJI BERSIES
2| 1 |pEsi 118 3 1.500.000 400.000 | 200.000 | 2200000 19.800| 2.180.200
o 2 [Nina I 2 1.000.000 300.000 | 200000 1.500.000| 12.000| 1488.000
a| 3 [arva I1A 1 2.000.000 500.000 100.000 | 2.600.000 | 26.000 | 2.574.000
s| 4 Jwawan I 3 1.000.000 300.000 | 300000 1.600.000| 12.800| 1.587.200
5| 5 [Buni 1B 0 1.500.000 400.000 - 1.900.000 | 17.100 | 1.882.900
7| 6 [ADE I 3 1.000.000 300.000 | 300000 1600.000] 12.800| 1.587.200
o[ 7 [wam 118 2 1.500.000 400.000 | 200.000 | 2.100.000| 18900 2.081.100
5| 8 |ADE Diasy ~ 2 2.000.000 500.000 | 200,008 #24700,000 |) 27.000 | 2.673.000
w| 9 [HARI T 1 2.000.000 500.000 100.000 “2.600:000°~ 26.000 | 2.574.000
u [ 10 [asep 1A 2 2.000.000 500000 | 200.000 | 2.700.000 | 27.000 | 2.673.000

2. Pilih Tab Ribbon Home = Conditional Formatting.
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f'/‘ Home Tnsert Page Layout Formulas Data Review Wi Add-Ins Design
B 35 cut Calibri BT | Sivirap Text General - ij" ﬁj—é‘ ';r:i j‘:‘] :?\ _;J ;A“m”m' %
EL = - Fill =
fania jF:rpr:at painter ||[BL || | - A-| = = 3E|| o Merge & Center - || § ~ % 9 || %8 25| anﬂvlﬂmﬂaigﬁgl a:?;fg‘a:_ Swﬁi‘l_ IR Bats Remd zcl‘ea” Fsﬁt":r'-’f
Clipboard r] Font F] Alignment F] Murnber F] o J Editing
| D1 - ( f,‘ JUMILAH ANAK )] Higniight Cells Rules > fﬂ Greater Than...
2. 2 C L E L "ﬁm% Top/Bottom Rules =] Less Than... Y
A N NAMA [ GOLONGAIE JUMLAH ANAF) GAJI POKOE  INTENSIF g Tu s 5 | BERSIiEy
2| 1 |DESI 1B 3 1.500.000 400.000 B atanans v | B=H Between.. 180.200
a2 |NINA Ic 2 1.000.000 300.000 _ s 188.000
a3 |ARYA 1A 1 2.000.000 500.000 e * L) EaulTo~ 574.000
s 4 |WAWAN I 3 1.000.000 300.000 ] wonses 2] ottt comans.. 587.200
¢ 5 |BUDI B 0 1.500.000 400.000 o 382.900
| Wew ot = ]
7 6 |ADE I 3 1.000.000 300.000 j e , =] avseocmima. 587500
e 7 |WATI B 2 1.500.000 400.000 BBy Manage Bultes.. = mtetevse, 281100
s 8 |ADE 1A 2 2.000.000 500.000 200000 | 27000 — 573.000
w9 |HARI 1A 1 2.000.000 500.000 100.000 | 2.600.Loe o ierere—e:574.000
1| 10 |ASEP 1A 2 2.000.000 500.000 200.000 | 2.700.000 | 27.000 | 2.673.000 |

3. Pilih jenis kondisi sesuai yang diinginkan, misalkan Highlight Cells Rules = Equal To...
4. lsi data kondisi atau syarat yang diinginkan dan jenis penandaan.

| Format cells that are EQUAL TD:

H |o E with [Light Red Fil with Dark Red Text =]
1 LGt Red Fil with Dark Red Test
ellow Fill with Dark Yellow Text
Green Fill with Dark Gresn Text

ight Red Fill

00.000 500.000 |  [mere

Red Border
Aann AN ! can ann | Custom Format...

5. Maka sel data pada kolom JUMLAH ANAK yang bernilai 0 akan ditandai dengan warna sel merah.

6.2.5. Mengenal Fasilitas Freeze Panes dan Split

Fasilitas Freeze Panes dan Split digunakan jika kita bekerja dalam sebuah sheet dengan banyak data baris dan
kolom. Fasilitas Freeze Panes akan membuat tampilan pada worksheet kita dengan posisi kolom dan baris
tertentu tetap dan yang lainnya bergerak/berubah jika kita geser posisi scroll-nya. Fasilitas ini bisa didapatkan
pada Tab Ribbon View - Freeze Panes.

 Excel Table Toals

Wie Add-Ihs Design

.% j E‘J _I__EI % E = split ) iew Side by Side -
e — I Hide 33 Synchronous Scrolling i;‘
Zoom  100% Zoom to Mews  Arrange |Freeze Sawe

Selection || Window Al [Panes -] Unhide | 24 Reset Window Position | waorkspace

Zoom Freeze Panes
E Keep rowes and columns visible while the rest of

the worksheet scrolls [hased on current selection).
Freeze Top Row

- Keep the top row visible while scrolling through
B GAIl POKOH INTENSIF the rest of the worksheet,
Freeze First Column
Keep the first calumn visible while scralling
through the rest of the worksheet.

Pilihan yang tersedia adalah Freeze Panes, Freeze Top Row dan Freeze First Column.

1. Freeze Panes . Jika kita posisikan kursor pada sebuah sel lalu memilih Freeze Panes,
maka daerah kolom pada sel tersebut ke arah kiri dan baris sel tersebut ke arah atas akan membeku.
Dengan kata lain jika scroll bar kita geser ke kanan dan ke kiri maka data setelah sel tersebut saja yang
akan bergerak sedangkan data yang beku tadi akan tetap pada tempatnya.

2. Freeze Top Row : Pilihan ini jika kita ingin membekukan tampilan data hanya pada baris
pertama saja
3. Freeze First Column : Pilihan ini jika kita ingin membekukan tampilan data hanya pada kolom

pertama saja

Untuk fasilitas atau fungsi Split, fungsinya hampir sama dengan Freeze Panes. Namun fungsi Split berguna
untuk memisahkan tampilan. Daerah yang dipisahkan tidak bersifat beku dan bisa digeser menggunakan scroll
bar.
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